
VS Code használata C és 
Python környezetben

c-ben írt python modulon keresztül



Felhasznált irodalom és internetes tartalom
● A szerkesztő bemutatása a hivatalos Visual Studio Code dokumentáció 

alapján lett létrehozva
https://code.visualstudio.com/docs

● Példakódhoz vett forrásanyag 
https://learn.microsoft.com/en-us/visualstudio/python/working-with-c-cpp-pyth
on-in-visual-studio?view=vs-2022

● A példakódok a https://highlightjs.org/ használatával lettek színezve a 
base16-atelier-heath-light témát használva
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Visual Studio Code bemutatása

● A Visual Studio Code egy nyílt forráskódú több platformos kódszerkesztő amit 
2015-ös bejelentése óta a Microsoft fejleszt. Alapja az Electron framework, 
ami egy NodeJs környezetben futó böngésző alapú asztali 
alkalmazásfejlesztő keretrendszer. A fő kódok Javascript-ben és C-ben 
íródnak a megjelenítésért HTML CSS és Javascript felel.

● GitHub-on elérhető a kód és a bináris telepítő is több platformra 
https://github.com/microsoft/vscode

● Több programnyelvhez beépített IntelliSense támogatást tartalmaz, ami 
szintaktikai kiemeléseket és ellenőrzést és kódkiegészítést végez

● Saját bővítmény könyvtárral rendelkezik (Visual Studio Code Marketplace)
● A beállítások online fiók összekapcsolásával szinkronizálhatóak több gép 

használata esetén (Github vagy Microsoft fiók használatával)
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● Több füles és osztott képernyős elrendezésű, megnyitható egy fájl is, de 
hatékonyabb a Munkaterület kezelését használni ami GUI-n keresztül és Json 
szerkesztéssel is testre szabható. Kinézete témák segítségével alakítható

● A parancsok többsége menüből vagy gyorsbillenytűkkel elérhető, de az 
összes parancs egy parancskészletből előhívható (ctrl + shift + p)

● Beépített verziókövető támogatást tartalmaz ami az oldalsávban elérhető és 
alapértelmezetten a GIT

● beépített Debugger támogatással rendelkezik, ami több nyomkövetési módot 
támogat és paraméterezhető

● Beépített tesztelő oldalpanelen keresztül szintén több tesztelési módot 
támogat

● Általában véve testreszabható ezáltal több keretrendszer, fejlesztési platform 
alapja lett a megjelenése óta pl.: PlatformIO

● Online is elérhető https://vscode.dev
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VS code telepítése windows környezetben
● A telepítő letölthető a https://code.visualstudio.com/ oldalról
● A letöltött VSCodeUserSetup-x64-1.82.0.exe elindításával a program a 

szerződés elfogadása után gyorsan telepíthető ( a fájl neve a verziószámot és 
a platformot is tartalmazza ezért ez a későbbiekben eltérhet)

● A telepítés végeztével a szerkesztő elindul egy üdvözlő képernyővel amin egy 
funkció bemutató is elérhető (angol nyelven) Get Started with VS Code vagy 
kezdhetjük a kódszerkesztést a Start alatt elhelyezkedő Linkekkel is. 
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Program részei
A.) Tevékenység sáv. A bal szélen található, 
lehetővé teszi a nézetek közötti váltást,

B.) Oldalsáv. Különböző nézeteket 
tartalmaz, például az Intézőt, hogy segítsen 
a projekten való munka során.

C.) Szerkesztők. A fő terület a fájlok 
szerkesztéséhez. Tetszőleges számú 
szerkesztőt nyithat meg egymás mellett 
függőlegesen és vízszintesen.

D.) Panel. Alapértelmezés szerint kimenetet, 
hibakeresési információkat, hibákat és 
figyelmeztetéseket, valamint egy integrált 
terminált tartalmaz. A panel balra vagy 
jobbra is mozgatható.

E.) Állapotsor. Információk a megnyitott 
projektről és a szerkesztett fájlokról.

Egy másodlagos oldalsáv is elérhető az elsődleges oldalsávval szembeni 
nézetek megjelenítéséhez. A Ctrl+Alt+B billentyűkombinációval lehet 
megjeleníteni.

A VS Code minden egyes indításakor ugyanabban az állapotban nyílik 
meg, mint amikor legutóbb bezárta. A mappa, az elrendezés és a 
megnyitott fájlok megmaradnak.6



Tetszőleges számú szerkesztőt nyitható meg egymás 
mellett függőlegesen és vízszintesen. A képernyő tetején 
Tabokban (lapokban) is lehet a váltani a megnyitott fájlok 
között.
A fájlok közötti váltáshoz billentyűzeten a Ctrl + Tab al lehet 
váltani. Az osztott szerkesztők között pedig a Ctrl + 1 2 …

Menüben a View -> Editor Layout pontban még több 
elrendezés választható (később még bemutatásra kerül)

A minimap egy átfogóbb betekintést nyújt az épp aktuális 
kódra. Megkönnyíti a kódban való mozgást. Szürke 
területtel jelöli az egy ablakban megjeleníthető kódrészletet 
és a szürke sávot húzva mozoghatunk a kódban.
A szintaktikai hibás sorok pirossal kiemelve jelennek meg 
és egyébként is követi a kód színezését.
A minimap kikapcsolható vagy áthelyezhető.

Szerkesztő felület és Minimap
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Fájlkezelő
A tevékenység sáv legelső eleme a fájlkezelő

Felső rész a megnyitott fájlok felsorolása
Lentebb a munkaterület fájljai és mappái,
a mappák kinyithatóak és bezárhatóak a 
könyebb átláthatóság érdekében

A fájlon jobb gombra menü nyílik meg alap fájl műveletek 
végezhetőek (átnevezés, törlés). Hasznos lehet a fájl 
nevének másolása (Copy path és Copy Relative Path)

Open Timeline, a fájlon
elvégzett műveletek listáját
kapjuk időrendben
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Breadcrumbs (zsemlemorzsa)
A szerkesztő felett található egy 
navigációs sáv ahol egérkattintásra
gyorsan lehet mozogni mappák és fájlok
között. 

Összetettebb mappa 
struktúránál lehet hasznos

Az utolsó bejegyzés az 
aktuális kódban az aktuális
függvény neve amennyiben 
egy függvényben áll a 
cursor. Ilyenkor az elérhető
függvények között is lehet 
mozogni
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Keresés és csere a tevékenység sáv második pontja
A megnyitott fájlok vagy ha munkaterülettel 
dolgozunk a munkaterületen lévő  fájlok tartalmában 
lehet keresni. A keresőmező melletti ikonok:
Aa - Kis nagybetű különböző
ab - Szóra keres
_* - reguláris kifejezés is megadható

… - További szűrések megnyitása
files to include - csak a megadott feltétel szerinti 
fájlok szűrése
files to exclude - a megadott fájlok kizárása 
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Keresés és csere a tevékenység sáv második pontja
A keresett értékek cserélhetőek is.
Ha a találati listában rákattintunk egy értékre
Akkor osztott nézetben megjelenik az adott fájl 
előtte, utána nézete

Választható az összes cseréje, ilyenkor egy 
megerősítés kérés után a munkaterület összes 
fájljában cserére kerül a megadott kifejezés
(alkalmazása körültekintést igényel)
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Parancskészlet
A parancskészlet tartalmazza az összes elérhető utasítást amit a szerkesztő 
ismer. A Ctrl + Alt + P billentyű kombinációval előhívható és a szerkesztő felső 
sávjában középen jelenik meg (később erre a területre felső sávként hivatkozom)
Elkezdve a gépelést a találatok szótöredékre szűrve jelennek meg.
Az eredmények a felhasználás gyakorisága szerint rendeződnek, így a gyakran 
használt funkciókat előrébb találjuk, a gyorsbillentyűk is megjelennek jobb oldalt.
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Nézetek és Zen mód
A rengeteg panel és nézet típus között el 
lehet veszni, erre megoldás, ha tudjuk, hogy 
melyik képernyőt szeretnénk elérni akkor 
billentyűzetről is el tudunk navigálni az épp 
kellő nézethez. Ctrl + P -re megnyílik a felső 
kereső és oda beírva a view (nézet) szót 
megjelennek az elérhető nézetek. Menüből 
is elérhető, 
View -> Open View… 
Zen mód
Ebben a nézetben csak az aktuális
fájl jelenik meg, az összes egyéb 
panel el lesz rejtve. 
Ctrl + Alt + P után toggle zen mode
13



Rácsos elrendezés - Grid mode
Nem csak oszlopokban rendezhetők a megnyitott fájlok, hanem rácsos módban is.
Menüből elérhető View -> Editor Layout -> Grid (2x2)
Parancskészletből > Grid Editor Layout (2x2)
A megnyitott fájlokat behúzhatjuk az általunk kívánt részére a rácsnak
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Témák, sötét téma és fájl ikonok
Több színséma (téma) választható alapértelmezetten vagy 
a VS Code Marketplace-ről is telepíthetőek témák. Világos 
és sötét témák közül választhatunk. Első indításkor a 
rendszer beállítások szerint indul.
Windows és Linux (disztibuciónként változhat) alatt is már 
beállítható az alap rendszer téma, hogy világos vagy sötét 
legyen. 
Menüből File -> Preferences -> Theme -> Color 
Theme

A színsémákkal a syntax highlight is változik
Megváltoztatható a fájlok ikonjai is, menüből ugyanitt 
File Icon Theme

Minden téma testreszabható
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Munkaterületek beállításai
A megnyitott fájlok vagy egy mappa 
fájljai munkaterületbe rendezhetőek.
A munkaterület külön testre 
szabható. Akár külön témát 
rendelhetünk az adott 
munkaterülethez, a szerkesztő 
beállításait módosíthatjuk 
munkaterületenként. Adott 
munkaterület adott fájljára is 
megadhatunk külön beállítást (pl.: 
karakterkódolás)
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Billentyűzet parancsok
A billentyűzet parancsok meggyorsítják a munkát. VS Code esetén minden parancs 
gyorsbillentyűhöz rendelhető, de bővítményként komplett gyorsbillentyűzet kiosztás is 
telepíthető. Számomra nagyon hasznos a Notepad++ keymap 
Hasznos és általában egységes billentyűzet kombinációk:
Ctrl + P fájlhoz ugrás
Ctrl + Shift + P parancskészlet

Menüből elérhető a gyors-
billentyű hozzárendelő felület
File -> Preferences -> 

Keyboard Shortcuts

Ezen a felületen minden 
testreszabható
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Összecsukhatóság Folding
A különböző kódblokkok tetszőlegesen összecsukhatóak, így növelve az 
átláthatóságot a kódban. A kódblokkok nyelvenként eltérőek lehetnek.

A nyilak abban az esetben jelennek meg ha az egeret a sorszámok utáni üres 
mezőre húzzuk és itt kattintással lehet ki és becsukni az adott kódblokkot.
Az összes kódblokk is ki és becsukható a parancskészletben a Fold All és 
Unfold All parancsokkal.
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Oszlopos és több kurzoros kijelölés
Lehetőség van több kurzoros kijelölésre és akár adatbevitelre és törlésre is.
Billentyűzettel az Alt + Shift és fel / le nyíl billentyűvel lehet több sorra kiterjeszteni 
a kijelölést. Több soron Visszatörlés és Törlés is alkalmazható valamint gépelve 
minden kijelölt soron megjelenik a begépelt szöveg.

Alt + Shift + Bal egér gomb megnyomásra pedig
a kezdeti pozíciótól a kattintott területig lesz kijelölve
doboz szerűen az adott részlet
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Kiegészítők telepítése, VS Code Marketplace 
A bővítményekkel kiegészítheti az eleve bő 
lehetőségeit a szerkesztőnek.
A kiegészítők között kereshet szöveg alapon, az 
eredmények szűrhetőek
kategóriánként
A keresési eredmények 
között a kiegészítőre 
kattintva egy leíró oldal
jelenik meg.
A bővítmény az Install
gombra kattintva 
telepíthető. Ha nincs rá 
szükség akkor az 
uninstallal eltávolítható
20



IntelliSense kódkiegészítés
Az adott programnyelvhez tartozó függvények, osztályok névkiegészítését végzi. 
Ezen felül a kódban definiált változók neveire és osztályaira is a gépelést 
követően felajánlja a lehetséges értékeket. Ezen felül megadja függvények esetén 
a paraméterek neveit. 

Ha használunk
kommenteket a saját 
változókra vagy 
Függvényekre
azok is 
megjelennek
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Navigáció a fájlok között és a kódon belül
A munkaterület fájljai között
gyors navigációt tesz 
lehetővé a Ctrl + P kereső

Kódon belül a funkciókra 
ugrás Ctrl + Shift + O 

Adott sorra ugrás
Ctrl + G

Szimbólum keresése
a munkaterületen
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Navigáció a fájlok között és a kódon belül
Ugrás a kurzor pozícióban lévő változó 
definíciójára F12

Ugrás a kurzor alatt lévő
változó hivatkozásaira.
Ilyenkor egy plusz ablak
jelenik meg a pozíció alatt
ahol felsorolásra kerül az 
összes előfordulás

Ugrás a zárójel párjára Ctrl + B
Egyéb blokkok esetén is működik
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Változó átnevezése és szabványos komment blokk generálás
Változó átnevezése Rename symbol

Komment blokk generálása
Generate Doxygen Comment
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Copilot, mesterséges intelligencia
Fizetős a Copilot, aktív github előfizetés szükséges hozzá.
Az AI több módszer szerint
dolgozik, figyeli az adott
kódon belül alkalmazott 
sajátosságokat, de a 
munkaterület többi fájlja
alapján is dolgozik.
Van hogy olyan technikát
ajánl amit korábban nem 
használtam és nagyon
hasznos, hogy a comment
ekben is tesz ajánlásokat
mindezt magyar nyelven.
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Copilot Chat, MI csetelés
Megjelent egy új lehetőség ahol cseveghetünk az AI-val.
A tevékenység sávban megjelenik a Chat funkció.
A kívánt feladatokat szövegesen megfogalmazva 
kódrészleteket vagy akár teljes kódot jelenít meg az 
oldalsávban. Működik magyar és angol nyelven is, de 
magyarul nagyobb eséllyel kapunk kitérő választ mint 
kódot.
A magyarul megfogalmazott kérésre magyar válasz 
érkezik, az angolra angol (más nyelvet nem próbáltam).
A chat az aktív ablakban lévő kód környezetét 
felhasználva alakítja ki a választ igazodva az aktív kód 
programnyelvéhez.
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Copilot Chat, MI csetelés
Angol nyelven az “add new function double” 
utasításra az oldalsávban megjelenítette a kódot. 
Ebben az esetben az új funkciót megjelenítette, 
de a korábban ott lévőt (négyzetre emelés) nem, 
de utána hivatkozott a “fast_square” függvényre. 
Azaz ez a javaslat csak szerkesztéssel 
eredményezett fordítható kódot.
Az include-ok közül is kihagyta a math.h -t, ezt a 
későbbiekben is következetesen kihagyta.
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Copilot Chat, MI csetelés
A következő utasítást magyar nyelven 
fogalmaztam meg és egy nehezebb 
feladatot kértem tőle, ahol használni kellett 
olyan függvényeket amelyek nem voltak az 
előző kódban és azokat be is kellett 
regisztrálni, hogy működő kódot kapjunk.
Ezt a feladatot nagyon jól megoldotta, egy 
fordítható működő kódot adott a válaszban. 
Most minden korábbi funkciót is felsorolt 
egyedül az include-ot hagyta ki. A fordításra 
is adott használható javaslatot.
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Copilot Chat, MI csetelés
A következő utasítást csak angolul volt 
hajlandó végrehajtani. Itt a python 
kódban kértem tesztelő funkciókat.
Egy működő és használható tesztelő 
kódot adott válaszban. Minden 
eredményre helyes választ adott.
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Copilot Chat, MI csetelés
Végül arra kértem egy 
mondatban angolul, hogy 
készítsen egy programot, amit 
én internetes keresésekből és 
saját ötletből készítettem ehhez 
az előadáshoz. Ezt hibátlanul 
megoldotta, még átadott 
paraméter ellenőrzést is tett 
bele ami az én megoldásomból 
kimaradt.

30



Tevékenység sáv, verziókövetés GIT
Az oldalsávban megjelennek a módosított fájlok. A fájlra kattintva megjeleníti a 
korábbi és a jelenlegi verzió közötti változásokat. Színezéssel jelöli a törölt (piros) 
és az új részeket (zöld)
A commithoz a fájl változás esetén hozzáadható + vagy visszavonható egy 
változtatás ↺. A fájl neve mellett M jelöli a változást, D a törölt, U az új fájlt
Az új commit és a remote repository szinkronizálás is elvégezhető a sávban.
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Snippets kódtöredékek
Nyelvenként változó kódrészletek 
hozhatók létre, miután elkezdjük beírni
az utasítást és Ctrl + Space paranccsal 
a Code snippets -el kezdődő sort választjuk

További snippets-ek telepíthetőek a Marketplace-ről vagy magunk is hozhatunk 
létre. 
A példa egy javascript for
ciklust tartalmaz
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Tesztelő, python tesztelő beállítása
A tevékenységsávban a tesztelést választva az oldalsávjában
válasszuk a Configure Python Tests pontot. Megjelenik egy kérdés a 
felső sávban ahol a pyTest -et válasszuk.
A fájlokban megkeresi a teszteket és a háromszögre kattintva futtatja 
azokat. Az eredményeket hiba esetén a szerkesztőben jeleníti meg
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Python nyelvi munkaterület létrehozása
Python esetén a futtatókörnyezetet lehet
meghatározni, a verzióra kattintva 
a fenti sávban jelennek meg a választható
opciók.
Enter interpreter path… pontban új 
futtatókörnyezet is gyorsan hozzáadható.
A kiválasztott interpreter nincs hatással a linter működésére, a python 2 szintaktika 
nincs támogatva, így hibát fog mutatni az amúgy 2-es pythonban lefutó kód.
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Python hibakereső (debug) környezet beállítása
A tevékenység sávban található a hibakereső panel.
A Run and Debug gombra kattintva a felső sávban választhatunk
több környezet közül, mi most a Python File-t válasszuk

Töréspontot a sorszám melletti területre kattintva vehetünk fel

Az oldalsávban
karbantarthatóak az
aktív töréspontok
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Python hibakeresés
A hibakeresés menüből Run -> Start Debugging vagy F5 billentyűvel indítható
A töréspontnál az oldalsávban megjelennek az aktuális
változók az épp aktuális értékeikkel.
Megfigyeltethetőek a változók a WATCH panelen is, itt
megadható függvény is (a példában a b változó hexában)
A Run menüpontban láthatóak
az elérhető funkciók, amik gyors
billentyűvel is elérhetőek.
A felső sávban megjelenő 
gombokkal is vezérelhetjük a futást
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C nyelvi munkaterület létrehozása
Beállítható a fordítási környezet
Én a gcc 64bites verzióját
használom

Megadható saját definíció

  A végeredmény egy JSON fájl, ez akár kézzel is
  létrehozható, módosítható.
  További fordítók is hozzáadhatóak a Marketplace
  segítségével.
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C nyelvi munkaterület létrehozása
A mintapéldánk hibát jelez, mert
nem találja a “Python.h” header
fájlt. Ezt javíthatjuk, ha beállítjuk a 
munkaterületünkre vonatkozó include keresési könyvtárakat

A win32-re kattintva megjelenik a felső
sávban egy menü, itt érdemes a UI 
konfigurációval elvégezni a beállítást.

Az include path részben felvéve a könyvtárat, megszűnik a hiba.
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C fordítás és hibakeresés beállítása
Amikor cpp fájl az aktív a szerkesztőben a jobb
sarokban a nyíl ikon melletti lenyíló ikonra kattintva
válasszuk a Run C/C++ File pontot

A felső sávban válasszuk a
build and debug active file -t
tartalmazó sort.

Ez a művelet létrehoz egy tasks.json fájlt és új bejegyzést tesz a launch.json 
fájlba. A fájlok a .vscode mappába kerülnek. A tasks.json a fordításért felel, a 
launch.json pedig a debug futtatásért.
A launch fájl már korábban létrejött amikor a python debug-ot futtattuk.
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C fordítás és hibakeresés beállítása
Amiket módosítani kell:
label - bekerült, hogy DLL-t fordítunk
args - tömbként a fordítási paraméterek
-static-* - ne használjon runtime -ot
-shared - DLL-t fordítunk
-I/python38/include - a python.h helye
/python38/python38.dll - a dll-ben lévő 
függvényeket használjuk, nem statikust
-o utáni paraméterben a .exe -t .pyd-re 
átírjuk
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C fordítás és hibakeresés beállítása
Amiket módosítani kell:
name - hogy felismerhető legyen, DLL kerül 
bele
program - itt a python.exe, mert azt indítjuk
args - átadjuk a py fájlt, hogy azt futtassa
cwd - ${fileDirname} a fájluk könyvtára
environment - ezt csak akkor kell 
beállítani, ha a környezeti változók nem 
tartalmazzák
preLaunchTask - az előző dián a label 
amivel fordítunk
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Hibakeresés C/C++ program esetén
a cpp fájl legyen kiválasztva a szerkesztőben
a zöld nyíl mellett nyissuk le a választót
és válasszuk az előző dián megadott labelt
C/C++: g++.exe build DLL file

A zöld nyílra kattintva
lefut a programunk,
alul a Panel sávban a 
Terminal fülön 
megjelenik a program
kimenete
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Hibakeresés C/C++ program esetén
Hozzunk létre töréspontot és az előzőek szerint futtatva a kód megáll a 
töréspontnál, ahol ellenőrizhetjük a működést. C esetén a WATCH megjelenítőben
,h -val jeleníthetjük
hexában a változó
értékét
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A példakód fájljai
A példakód egy c/c++ python modult tartalmaz. Bemutatásra kerül, hogyan 
kommunikál a python a C-ben írt modullal. A c-ben megírt modulok pyd 
kiterjesztéssel fordított külső könyvtárak. Windows esetén DLL, linux esetén SO

● test_pyd.cpp - c python modul példakód
● test_pyd_cpp.py - python kód ami a péda modult hívja
● test_pyd.pyd - befordított modul, python 3.8 esetén működik, egyéb 

esetben újra kell fordítani
● .vscode/c_cpp_properties.json - a c linter beállításaira szolgáló fájl
● .vscode/tasks.json - a c kód fordítását beállító fájl
● .vscode/launch.json - a hibakerső futtattását beállító fájl. python 

3.8-hoz lett beállítva, más verzió esetén módosítást igényel
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A példakód c-ben írt python modul kódja
#include <math.h> 
#include <Python.h> 
/// @brief négyzetre emelés 
/// @param nem használt objektum referencia a modulra 
/// @param o maga a paraméter 
/// @return a négyzetre emelt érték 
PyObject* square_impl(PyObject* /* unused module reference */, PyObject* o) 
{ 

double x = PyFloat_AsDouble(o); 
double pow_x = pow( x , 2 ); 
return PyFloat_FromDouble(pow_x); 

} 
PyObject* double_impl(PyObject* /* unused module reference */, PyObject* o) { 

double x = PyFloat_AsDouble(o); 
double doubled_x = x * 2; 

return PyFloat_FromDouble(doubled_x); 
} 
PyObject* multiply_impl(PyObject* /* unused module reference */, PyObject* args) { 

double result = 1.0; 
int arg_count = PyTuple_Size(args); 
for (int i = 0; i < arg_count; ++i) { 

PyObject* o = PyTuple_GetItem(args, i); 
double x = PyFloat_AsDouble(o); result *= x; } 

return PyFloat_FromDouble(result); 
}
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A példakód c-ben írt python modul kódja
static PyMethodDef superfastcode_methods[] = { 

{ "fast_square", (PyCFunction)square_impl, METH_O, nullptr }, 
{ "fast_double", (PyCFunction)double_impl, METH_O, nullptr }, 
{ "fast_multiply", (PyCFunction)multiply_impl, METH_VARARGS, nullptr }, 
{ nullptr, nullptr, 0, nullptr } 

}; 

static PyModuleDef test_pyd_module = { 
PyModuleDef_HEAD_INIT, "superfastcode", "Provides some functions, but faster", 0, superfastcode_methods 
}; 

PyMODINIT_FUNC PyInit_test_pyd() { 
return PyModule_Create(&test_pyd_module); 

}
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A példakód python fájlja ami a C modult hívja
from test_pyd import fast_square, fast_double, fast_multiply

def test_fast_square(): 
assert fast_square(3) == 9.0 
assert fast_square(4) == 16.0 
assert fast_square(5) == 25.0 

def test_fast_double(): 
assert fast_double(3) == 6.0 
assert fast_double(4) == 8.0 
assert fast_double(5) == 10.0 

def test_fast_multiply(): 
assert fast_multiply(3, 4) == 12.0 
assert fast_multiply(2, 3, 4) == 24.0 
assert fast_multiply(5, 6, 7, 8) == 1680.0

def test_fast_square_error(): 
assert fast_square(3) == 8

if __name__ == '__main__': 
print(fast_square(3)) 
print(fast_square(4)) 
print(fast_square(5))
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